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Um Blender mit zusätzlichen Funktionen zu erweitern, gibt es grundsätzlich zwei Wege: Python-Add-ons und Open-
Shading-Language-Skripte. Beides sind keine Plug-ins im eigentlichen Sinn, können den Umfang der Software aber 
massiv erweitern. Dank der Import- und Export-Funktionalitäten von Blender kann man sich die Funktionen mancher 
Add-ons auch zunutze machen, ohne viel mit dem Programm in Kontakt kommen zu müssen – so geschehen bei der 
Previsualisierung von „Avatar“. Dort wurde Blender nur eingesetzt, um über das 2.4x-Add-on „Trees from Curves“ 
Bäume aus Bezier-Kurven zu generieren. Dieser Artikel behandelt ausschließlich Python-Add-ons und stellt eine Aus-
wahl an besonders nützlichen Erweiterungen vor. von Gottfried Hofmann

Die besten Plug-ins für Blender

Die offizielle Blender-Version ist be-
reits mit einer Vielzahl von Add-ons 
ausgestattet. Zahlreiche Import- und 

Export-Formate sowie die Render Engine 
Cycles sind standardmäßig aktiviert, der 
Rest kann manuell zugeschaltet werden über 
File > User Preferences > Add-ons. In der 
DP-Ausgabe 05/14 wurde bereits die Nütz-
lichkeit der Add-ons „Animall“ und „Import 
Images as Planes“ beschrieben. Es warten 
aber noch viele weitere Perlen darauf, mit 
einem Klick aktiviert zu werden.

Das Add-on „Sapling“ erstellt prozedu-
rale Bäume aus diversen Parametern. Es 
handelt sich um einen Port der Standalone-
Software Arbaro (arbaro.sourceforge.net). 
Links oben fi nden Sie ein Feld für die Suche 
nach bestimmten Add-ons, geben Sie hier 
„Sapling“ ein. Aktivieren können Sie Add-
ons über einen Klick auf das Häkchen an 
der rechten Seite neben dem Symbol eines 
rennenden Strichmännchens. Auf diese Art 
aktivierte Add-ons können bis zum Schlie-
ßen der Session genutzt werden. Wenn Sie 
ein oder mehrere Add-ons dauerhaft nutzen 
wollen, können Sie die aktuell aktivierten 
Add-ons links unten über „Save User Set-
tings“ dauerhaft speichern. Diese bleiben 
dann auch beim nächsten Start von Blender 
aktiviert.

Nutzen können Sie den Sapling Tree Ge-
nerator über Shift + A beziehungsweise Add > 
Curve > Add Tree. Die Einstellungen fi nden 
Sie links unten im Toolshelf oder in einem 
Pop-up, das sich mit der Taste F6 öffnen 
lässt. Einige Presets erleichtern den Einstieg, 
kümmern sich aber nur um die Basisform. 
Eine Dicke für den Stamm (Bevel) und Blät-
ter müssen erst noch aktiviert werden. Auf 
Wunsch kann sogar ein Rig angelegt werden, 
das optional mit einer Wind-Animation ver-
sehen werden kann.

Es existieren noch viele weitere Add-ons, 
die bestimmte Objekte erzeugen können, 
zum Beispiel Edelsteine, Zahnräder oder 
Schrauben. Diese sind in „Extra Objects“ 
zusammengefasst. Hier fi ndet sich auch der 
berühmte „Utah Teapot“ für alle, die nicht 
immer nur den Affenkopf als Testobjekt nut-
zen wollen.

Effi  zienter mit Nodes arbeiten

Es fi nden sich auch zahlreiche Add-ons, die 
den Workfl ow verbessern oder einfach nur 
Funktionen nachreichen, die man bei Blen-
der schmerzlich vermisst. Der „Node Wrang-
ler“ ist hier ein Beispiel. Damit wird die Ar-
beit mit Nodes deutlich fl üssiger, auch wenn 
man dafür eine Reihe von neuen Shortcuts 
lernen muss. 

Dafür werden das Verbinden von Nodes 
und der Austausch von Sockets deutlich 
vereinfacht, zum Beispiel muss nur noch 
ein Strich gezogen werden werden, um 
die Ausgabe zweier Nodes zu mischen 
oder zwei Nodes zu verbinden – ohne die 
Sockets anwählen zu müssen. Dazu kommen 
Batch-Operationen für viele Nodes gleich-
zeitig, die Möglichkeit, einen Node einfach 
auszutauschen oder sämtliche Einstellungen 
eines Nodes auf einen anderen zu kopie-
ren. Der Node Wrangler rüstet Cycles auch 
mit einem „Viewer Node“ für Farbausgaben 
auf Basis eines Shadeless-Materials aus. Die 
Tas tenkombination dafür ist die gleiche wie 
im Compositor: Strg + Umschalt + Linksklick 
auf den zu inspizierenden Node. Das Material 
des ausgewählten Objekts wird dann durch 
ein Shadeless-Material ersetzt, wodurch 
sich das Aussehen von Texturen ohne Ne-
beneffekte wie Spiegelungen untersuchen 
lässt. Eine ausgiebige Dokumentation fi ndet 
sich im Blender Wiki unter wiki.blender.
org/ index.php/Extensions:2.6/Py/Scripts/
Nodes/Nodes_Effi  ciency_Tools.

We build to destroy

Ohne Features für Chaos und Zerstörung sind 
3D-Programme einfach nicht vollständig. In 
Blender werden dafür gleich zwei Add-ons 
mitgeliefert, wobei „Cell Fracture“ die mo-
dernere Variante ist. Mit Cell Fracture lässt 
sich ein Mesh in kleinere Teile „zertrümmern“, 
wobei die Teile auch gleich die richtigen 
Masse-Einstellungen für die Bullet Engine 
erhalten. Sprich: Nach dem Zertrümmern 
kann gleich mit der Physik weitergemacht 
werden. UVs der Außenhülle bleiben erhal-
ten, während die inneren Stücke mit einem 

anderen Material versehen werden können. 
Zum Erstellen der Bruchkanten werden ver-
schiedene Optionen angeboten, es lassen 
sich Partikel oder die Vertices des Meshes 
selbst respektive eines anderen Meshes ver-
wenden oder man zeichnet die Bruchkanten 
einfach selbst mit dem Grease-Pencil auf das 
Objekt. Nachdem man ein Objekt angewählt 
hat, erscheint der Cell-Fracture-Button im 
Toolshelf unter dem Reiter Tools > Edit.

Werkzeugkasten für 3D-Druck

3D-Druck ist groß im Kommen. Blender 
hat dafür einen ganzen Werkzeugkasten 
als Add-on an Bord: die „3D Print Toolbox“. 
Die se gliedert sich in fünf Bereiche. Erstens 
lassen sich Statistiken errechnen, wie zum 
Beispiel das Volumen und die Oberfl äche des 
Objekts inklusive aller Modifi er. Zweitens 
können Tests gefahren werden, die auf beim 
3D-Druck typische Gefahren hinweisen, wie 
etwa eine zu geringe Wandstärke oder Über-
hänge. Bei gefundenen Problemen wird der 

Die Liste der bei Blender schon 
mitgelieferten Add-ons ist lang …
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Nutzer direkt auf die entsprechenden Stel-
len aufmerksam gemacht. Drittens können 
manche Fehler mit den Clean-up-Tools 
 automatisch behoben werden, wie zum Bei-
spiel isolierte Flächen, die keine Dicke haben 
und daher sowieso nicht gedruckt würden. 
Verzerrte Flächen lassen sich triangulieren. 
Viertens kann das Objekt auf definierte 
Dimensionen oder ein defi niertes Volumen 
skaliert werden, was benötigt wird, wenn 

Limitierungen des 3D-Druckers eingehalten 
werden sollen. Fünftens kümmert sich das 
Add-on auch gleich noch um den Export in 
verbreitete Formate wie STL. 

Der Entwickler der 3D Print Toolbox hat 
ein umfangreiches Training erstellt, das 
über den Blender e-Store (bit.ly/1tqJMxp) 
bezogen werden kann und in der Blender 
Cloud verfügbar ist (cloud.blender.org/
training/3d-printing).

Add-on-Ökosystem

Die mitgelieferten Erweiterungen sind nur ein 
kleiner Teil der tatsächlich verfügbaren. Das 
offi  zielle-Add-on-Verzeichnis (wiki.blender.
org/index.php/Extensions:2.6/Py/Scripts) 
listet nicht nur die Dokumentation zu allen 
Haupt-Add-ons, sondern auch Doku- und 
Download-Möglichkeiten zu Add-ons, die 
sich noch in der Review-Phase befi nden 
(Contrib) oder die es noch nicht bis zum 
Review geschafft haben oder von externen 
Gruppen gepfl egt werden (External). Dann 
gibt es noch die unzähligen Add-ons, die 
über das Web verstreut sind. Für  diese ver-
sucht die Seite „Blender Add-on List“ (blen-
deraddonlist.blogspot.de) eine Übersicht 
zu erstellen. Seit kurzem können auf dem 
„Blender Market“ Add-ons käufl ich erwor-
ben werden. Bei diesen besteht die Aussicht, 
dass sie wie die mitgelieferten Add-ons noch 
für lange Zeit gepfl egt werden. Add-ons von 
extern müssen erst installiert werden. Dies 
geschieht über File > User Preferences > 
Add-ons > Install from File. Je nach Add-
on besteht der Download lediglich aus einer 
.py-Datei oder einer gepackten .zip-Datei. 
Entpacken Sie Letztere nicht, sondern wäh-
len Sie sie einfach im Blender-Dateibrowser 
aus, der bei „Install from File“ erscheint. Im 
Folgenden sollen aus dem Dickicht drei Per-
len herausgegriffen werden.

Kamerakalibrierung mit BLAM

Wer ein 3D-Objekt in ein Foto integrieren 
oder ein Foto für Camera Mapping nutzen 
will, sollte ein paar Daten zur Hand haben: die 
Höhe der Kamera über dem Boden während 
der Aufnahme und die Brennweite. Dann 
kann der Prozess zügig durchgeführt werden. 
Hat man die Werte gerade nicht zur Hand, 
hilft nur Probieren – oder im Foto fi nden sich 
Linien, die senkrecht zueinander stehen. In 
diesem Fall kann das Add-on „BLAM“ Abhil-
fe schaffen. Sie müssen nur vier Linien mit 
dem Grease-Pencil nachzeichnen und BLAM 
errechnet Brennweite und Perspektive. Auch 
einfache Werkzeuge für Reconstruction sind 
mit von der Partie. Das Add-on sowie Do-
kumentation und Tutorials fi ndet sich auf 
github.com/stuffmatic/blam.

Partikel nachrüsten – Molecular

Der Partikelsimulation von Blender fehlt 
für Kollisionen untereinander ein Radius 
um die Partikel. Ein solcher ist nur in der 
SPH-Physik implementiert, diese ist aber für 
Flüssigkeiten gedacht. Das Add-on „Molecu-
lar“ rüstet diese Funktionalität für sämtliche 
andere Physik-Typen wie Newtonian oder 
Boids nach. Dadurch lassen sich die Partikel 
in Blender für die Simulation von Sand, Dreck 

Mit dem Sapling-Add-on lassen sich in Blender prozedurale Bäume erstellen. Die große Zahl an 
Parametern gibt viel Raum für Feintuning und künstlerische Freiheit.

Eine unvollständige Auswahl der weiteren parametrischen Objekte, die über Add-ons 
hinzugefügt werden können.

Auch ein Werkzeug zum Zerstören von Objekten wird in Blender als Add-on mitgeliefert.
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Frederik Stein-
metz ist studier-
ter Biologe und 
hat sich auf die 
Visualisierung 
von biologischen 
Prozessen sowie 

die Modellierung von Tieren, vor 
allem von Insekten, spezialisiert. 
Seine Arbeiten finden sich auf 
Bio illustration.de. Außerdem ist 
er als Trainer für Blender aktiv 
und veröffentlicht Tutorials auf 
BlenderDiplom.com.

nen keine Änderungen mehr vorgenom-
men werden. Damit scheidet auch die Ani-
mation der Add-on-Parameter selbst aus. 
ARewO lässt sich über blenderdiplom.com/
de/downloads/543-arewo-ist-endlich-
in-die-gui-implementiert.html beziehen. 
Mehr zur Geschichte des Add-ons erfahren 
Sie im Interview mit Frederik Steinmetz.

Ausblick

Add-ons bieten Blender-Anwendern die 
Möglichkeit, die Software mit neuen Funk-
tionen auszustatten und Workfl ows zu op-
timieren. Für Entwickler ist es deutlich ein-
facher, Add-ons zu schreiben, als direkt am 
„Kern“ von Blender zu arbeiten. Die Blender-
Entwickler haben dem Rechnung getragen, 
indem Sie seit Version 2.67 die Möglichkeit 
anbieten, in Python eigene Nodes zu im-
plementieren. Seither haben sich einige 
Projekte daran gemacht, über eigens dafür 
defi nierte Nodes parametrische Modellie-
rung in Blender möglich zu machen. Es gibt 
derzeit mehrere Add-ons mit diesem Ansatz. 
Welches Add-on irgendwann das Rennen 
machen und mit Blender ausgeliefert wird, 
ist noch ungewiss. › ei

Gottfried Hofmann hat an der FAU 
Erlangen-Nürnberg Informatik studiert. 
Er arbeitet als Freelancer im VFX-Bereich 
sowie als Trainer für die freie 3D-Soft-
ware Blender. Als freischaffender Autor 
schreibt er für Fach- und Computerzeit-
schriften. Er hat zahlreiche Blender-Tuto-
rials verfasst, unter anderem für CG Tuts+ 
und CG Cookie. Weiterhin betreibt er die 
Webseite www.BlenderDiplom.com, auf 
der Blender-Tutorials in deutscher und 
englischer Sprache zur Verfügung stehen.
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3D-Druck-Werkzeugkasten: Die 3D Print Toolbox bietet Statistiken, Tests auf Fehler, Werkzeuge 
zum Bereinigen des Meshes, auf 3D-Druck zugeschnittene Skalierungsoptionen und kümmert sich 
auch gleich noch um den Export des Objekts.

Mit BLAM lässt sich die Kamera von Blender einfach anhand eines Fotos kalibrieren – solange 
senkrecht zueinanderstehende Linien und ein wenig Perspektive vorhanden ist. Links unten das 
Foto und vier eingezeichnete Linien. Oben die rekonstruierte Geometrie mit projiziertem Bild, 
was ebenfalls von BLAM erledigt wird. Rechts unten die Ansicht durch die Kamera. Der Shader 
der Treppe wurde dabei mit einem Wireframe-Shader gemischt.

ARewO für 
Blender

et cetera nutzen. Zusätzlich liefert Molecular 
ein Sys tem für simulierte Federn respektive 
Stoßdämpfer zwischen den Partikeln. Die 
damit realisierbaren Effekte 
reichen von Festkörpern, die 
zertrümmert werden können, 
bis hin zur Cloth-Simulation 
über Partikel. Als Inspiration 
für das Add-on diente Lagoa 
Multiphyiscs, das inzwischen 
in Softimage integriert ist. 
Anwender sollten aber keine 
Wunder erwarten – Molecu-
lar ist im Vergleich zu seinem 
großen Bruder sehr langsam.

ARewO

ARewO ist wie viele Add-ons 
aus der Not heraus entstan-
den. Ziel war es, wie mit 
dem Array-Modifi er Objekte 
schnell duplizieren zu kön-

nen. Die Animation der Objekte sollte aber 
erhalten bleiben und auf Wunsch um jeweils 
einige Frames versetzt werden können. An-

ders als der Array-Modifi er 
nutzt ArewO Instances, 
sodass die Duplikate mit 
Cycles fast ohne Overhead 
gerendert werden können. 
Die Größe kann anhand einer 
F-Curve verändert werden, 
weshalb sich ARewO auch 
für Sound-Visualisierungen 
eignet und wie beim Array-
Modifi er ist auch die Möglich-
keit gegeben, die Instanzen 
entlang eines Pfads anzuord-
nen. Der große Nachteil liegt 
allerdings in der Natur des 
Add-ons. Nach dem Ausfüh-
ren lassen sich die Parameter 
zwar noch verändern, aber 
sobald man an der Szene 
weitergearbeitet hat, kön-

Sanduhr mit dem Molecular-
Add-on: Trotz der recht ge-

ringen Anzahl an Partikeln hat 
die Simulation dieser Sanduhr 

bei 8OO Frames rund eine 
Stunde gedauert.
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DP: Wie kam es dazu, dass du dein erstes 
Blender-Add-on geschrieben hast?
Frederik Steinmetz: Ich probiere immer viel 
mit Blender aus. Ab und zu stoße ich auf 
simple Sachen, die mir fehlen. Eins davon 
war ein erweitertes Array, das mehr kann als 
der Modifi er. Dann habe ich gemerkt, dass 
ich das mit circa 20 Zeilen Code hinkrie-
gen kann. Als das funktioniert hat, habe ich 
beschlossen, dass man dieses leichte Script 
gut als Demo für andere Nicht-Python-
Gelehrte wie mich verwenden kann.

DP: Das hattest du zuerst als Script an-
geboten, das die Nutzer selbst ausführen 
müssen, zusammen mit einem Tutorial 
als Einstieg in Python. Wie weit war der 
Weg zum Add-on?
Frederik Steinmetz: Nachdem ich das Script 
für seine ursprünglichen Zwecke fertig-
gestellt hatte, sind mir immer mehr An-
wendungsmöglichkeiten eingefallen. Dabei 

bin ich auch auf Sachen gestoßen, die mit 
der ersten Version nicht funktioniert haben. 
Daraufhin habe ich ein weiteres Tutori-
al gemacht, in dem erweiterte Funktionen 
ermöglicht wurden, das allerdings, gerade 
wenn man viele Objekte verwendete, auch 
sehr viel langsamer war. Ein Add-on daraus 
zu machen, war eine spontane Idee, weil 
ich dachte, es wären einfach ein paar Zeilen 
mehr wegen der GUI.

DP: Da es jetzt ein Add-on ist, wurde auch 
die Handhabung für den Nutzer deutlich 
vereinfacht. Man muss es nur installieren/
aktivieren und kann interaktiv mit den Pa-
rametern arbeiten. Wie hoch war für dich 
der Aufwand, das GUI zu erstellen et cetera, 
verglichen mit der Kernfunktionalität?
Frederik Steinmetz: Als ich daran geschrie-
ben habe, habe ich mir immer wieder vor-

gestellt, wie jemand, der die Dokumentation 
nicht verfolgt hat, dieses Add-on benutzen 
wird. Daraufhin habe ich immer mehr Hil-
festellungen eingebaut und noch eine ab-
gespeckte Funktion geschaffen. Bei dieser 
muss man nur einen Knopf drücken, und 
schon sieht man etwas. Das war für den Fall 
gedacht, dass jemand durch die Funktionen 
abgeschreckt wird, für die man Voreinstel-
lungen vornehmen muss. Der kann dann 
ganz einfach herumprobieren. Später sind 
ein paar Köpfe wieder hinzugekommen, die 
man auch unabhängig benutzen kann, weil 
ich sie selbst praktisch fand. Dann muss man 
auch sehr viel Code darauf verwenden, da-
mit der Nutzer keine Fehlermeldung produ-
zieren kann. Letzten Endes kann man den 
Mehraufwand in Zahlen fassen: 20 Zeilen 
im Original, 710 als Add-on.

DP: Wie gut waren deine Vorkenntnisse in 
Programmierung allgemein, Python im Spe-

ziellen und Blender 
Python im Besonde-
ren, als du mit ARewO 
angefangen hast?
Frederik Steinmetz: 
Ich hatte einmal ein 
Script geschrieben, 
das Objekte im Raum 
verteilt, verbindet und 
zu Musik hüpfen lässt. 
Das war vollkommen 
unabhängig von den 

Objekten in der Szene und deshalb wesent-
lich weniger kompliziert. Außerdem hatte ich 
in Actionskript ein paar Flash Apps geschrie-
ben, unter anderem mit Away3D. Das alles 
hatte ich mir aus Beispielen von anderen 
Programmierern zusammen gebastelt und 
erweitert. Aber ich glaube, die Grundlagen 
habe ich tatsächlich noch aus der Schule. Da 
habe ich gelernt, was eine Variable ist und 
eine Schleife. Für simple Scripts braucht man 
gar nicht so viel mehr.

DP: ARewO war von Anfang an gut do-
kumentiert, zuerst Tutorials zum Aufbau, 
dann Tutorials zur Anwendung und eine 
Text-Dokumentation noch dazu. Würdest 
so einen Aufwand bei weiteren Add-ons 
wieder betreiben?
Frederik Steinmetz: Die Dokumentation über 
die Benutzung des Add-ons halte ich für Eh-

rensache (oder etwas 
weniger Pathetisches). 
Und da die Tutorials be-
liebt waren, würde ich 
wieder so vorgehen.

DP: Für was hast 
du ARewO bisher 
genutzt und hast du 
Beispiele von an-

deren Nutzern gesehen, die das Add-on 
einsetzen?
Frederik Steinmetz: Ich habe mit ARewO 
eine Biosynthese simuliert, die in meinem 
Showreel vorkommen wird, eine DNA-Helix 
erstellt, einen Tausendfüßer geriggt und die-
se aufklappende Dose, aus der der Rauch mit 
dem Blender-Symbol kommt. Bei anderen 
habe ich eine Boden-Austausch-Animation 
gesehen, für die das Script vermutlich ab-
gewandelt wurde und die Animation einer 
sich aufbauenden Mauer. Es gibt außerdem 
ein polnisches Tutorial zu ARewO. Und dann 
noch deine Sound-Visualisierung …

DP: Du versuchst grünes Licht für eine In-
tegration von ARewO in die Standardinstal-
lation von Blender zu bekommen. Welchen 
Prozess muss man durchlaufen, wenn man 
sein Add-on mit Blender ausliefern will?
Frederik Steinmetz: Es gibt verschiedene 
Standards, die man einhalten muss, und 

dann kann man es einschicken. Lizenz 
und Autoreninformationen müssen korrekt 
weitergegeben, ein paar Programmierstil-
Eigenschaften sollten eingehalten werden 
und man sollte eine detaillierte Bedienungs-
anleitung zur Verfügung stellen.

DP: Welche Tipps würdest du jemandem 
geben, der eine Funktionalität in Blender 
vermisst und diese per Add-on nach-
reichen möchte?
Frederik Steinmetz: Recherche! Wenn man 
neu anfängt, kann man mit einer API zu 80 
Prozent nichts anfangen. Deshalb sollte man 
nachschauen, ob es Ähnliches gibt. In den 
Code-Snippets von Blender sind tolle Beispiele 
und vor allem: Blender erlaubt es, jeden Schritt, 
den man macht, als Python-Befehl anzuschau-
en. So bekommt man schon einmal einen gu-
ten Überblick, was Python intern macht. › ei
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